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1. Dulezité

Tato elektronickd uzivatelskd prirucka je urcena
pro kazdého uzivatele tohoto monitoru Philips.
Pred pouzivdnim monitoru si prectéte tuto
uzivatelskou prirucku. Obsahuje dulezité informace
a poznamky k pouzivani vaseho monitoru.

Z3aruka Philips je platnd, pokud je vyrobek pouZzivan
pro navrzenou potrebu v souladu s ndvodem a

po prilozenf origindlu faktury nebo pokladnim
dokladem, oznacujicim datum ndkupu, jméno
prodejce a modelové a vyrobnf &islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

) Varovéni

Pouzitl kontrol, Uprav nebo postupt jinym
zpUsobem nez je stanoveno v této dokumentaci
muze vést k ohrozeni Sokem, elektrickym a/nebo
mechanickym riziklm.

Prectéte si a dodrzujte tyto instrukce pri
zapojovdn( a pouzivanf vaseho PC monitoru:

Pouzivani

*  Chrarite monitor pred primym sluncem, velmi
silnymi svétly a jinymi zdroji tepla. Dlouhodobé
vystaveni takovémuto plsobeni mize vést ke
ztraté barev a poskozeni monitoru.

»  Odstrarite veskeré predméty, které by mohly
spadnout do vétracich otvord nebo zabranit
dostatecnému chlazenf elektroniky monitoru.

*  Nezakryvejte vétraci otvory ve skiffice.

*  Umlistéte monitor na takové misto, ze kterého
bude elektrickd zdstr¢ka a zdsuvka snadno
pristupnd.

* Jestlize jste vypnuli monitor odpojenim
napdjeciho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte 6
sekund, aby monitor fungoval normainé.

* Vzdy pouzivejte napdjeci kabel schvéleny
spolecnostf Philips. Pokud napdjeci kabel chyb,
obrat'te se na nejblizsi servisni stredisko. (Viz
informace o strediscich zdkaznické péce)

*  Béhem pouzivani nevystavujte monitor
nadmérnym otresim nebo ndrazdm.

*  Pri pouzivani nebo premistovani do monitoru
nekopejte a zabrarte pripadnému padu.

Udrzba

* Aby byl tento monitor chrdnén pred moznym
poskozenim, nevyvijejte nadmérny tlak na panel
monitoru. Pri premistovéani zvedejte monitor
za ram; pfi zveddnf monitoru nesahejte rukou
nebo prsty na panel monitoru.

*  Nebudete-li monitor del3i dobu pouzivat,
odpojte jej ze zasuvky.

*  Pred odisténim mirné navihéenym hadrikem
monitor odpojte ze zdsuvky. Je-li vypnuté
napdjeni, lze obrazovku otfft suchym hadrikem.
K &isténi monitoru nikdy nepouzivejte
organicka rozpoustédla, jako napriklad alkohol
nebo distie s obsahem ¢pavku.

*  Zabrarite nebezped( Urazu elektrickym
proudem nebo trvalého poskozeni monitoru
a chrarite monitor pred prachem, destém,
vodou nebo nadmérmé vihkym prostredim.

* Pokud dojde k namoceni monitoru, co nejdrive

jej osuste suchym hadrikem.

*  Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizi ldtku nebo vodu z
monitoru a odedlete jej do servisniho strediska.

*  Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, pifmému
slunecnimu zdreni nebo extrémnim teplotdm.

*  Chcete-li zachovat optimalni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouZzivejte jej na misté, které splfiuje ndsledujici
rozsahy teplot a vihkosti.

o Teplota: 0-40°C 32-95°F
o Vlhkost: 20-80% relativni vihkosti



«  DULEZITE: Pfed ponechdnim monitoru bez
dozoru vzdy aktivujte spori¢ obrazovky. Bude-
li na vaSem monitoru zobrazen neménicf
se staticky obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky. Dlouhodobé
nepreerusované zobrazeni nehybného nebo
statického obrazu mize zpudsobit , vypaleni*
obrazovky, rovnéz zndmé jako ,,dosvit" nebo
,zobrazenf duchd".

* Vypdlenf",, dosvit" nebo ,zobrazeni duch(*
je dobre zndmy jev u technologie panell
monitoru.V mnoha pripadech ,vypéleni*,
,,dosvit"* nebo ,,zobrazenf duchd" postupné

zmizi po urcité dobé mimo provoz.

D Vystraha

Véazné priznaky ,vypdleni*, , dosvitu" nebo
,,zobrazenf duchd" nezmizf a nelze je opravit. Na
vyse uvedené poskozen( se nevztahuje zdruka.

Servis

*  Kryt plasté mize oteviit pouze kvalifikovany
servisni pracovnik.

*  Pokud je pro opravu vyZadovdna dokumentace
nebo integrace, obrat'te se na nejblizsi servisnf
stredisko. (Viz kapitola ,,Stredisko zakaznické
péce")

* Informace o preevdzeni najdete v ¢ésti
,, Technické Udaje".

* Neponechdvejte monitor v auté nebo
v zavazadlovém prostoru auta na primém
slunci.

© Poznamka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je tfeba provést po
provedeni pokynU v této prirucce, obratte se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nadsledujici pododdily popisuji zplsob zdpisu, ktery
se pouzivd v této prirucce.

Pozndmky, upozornénf a vystrahy

Na strankdch této prirucky mizete narazit na text,
ktery je opatreny symbolem a je vytistén tu¢né
nebo kurzivou.Takové Useky obsahuji pozndmky,
upozornénf a vystrahy. Jejich pouzitf je ndsleduijicf:

€& Pozniamka

Tento symbol oznacuje dudlezité informace a
navrhy, které poméhaji Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které objasriujf,
jak se vyhnout moznému poskozeni zarizeni nebo
ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezpedi té&lesného
ublizenf a vysvétluje, jak se danému problému
vyhnout.

Nékteré vystrahy se mohou objevit v riizné
podobé a nemusf byt uvozeny symbolem.V
takovém pripade je konkrétnl vyznacenf vystrahy
narizeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového materialu

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection.To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please
visit wwwi.philips.com/about/sustainability/recycling.




2. Uchopte monitor obéma rukama a pfipevnéte
2. Sestaveni monitoru stojdnek podstavce do sloupku podstavce.

(1) Jemné pripojte zékladnu ke stojanu

zékladny, dokud zdpadka zdkladnu nezajistf.
(2) Prsty utdhnéte Sroub umistény na spodnf
Kl Obsah krabice stran& zdkladny a ddkladng zajistste
zdkladnu ke stojanu.

2.1 Instalace

QS”{art

VGA (optional) DVI (optional)

B3 Namontuijte stojinek podstavce

1. Umistéte monitor obrazovkou dold na mékky
a hladky podklad, aby nedoslo k poskrabanf
obrazovky.




El Pripojeni k pocitali 2.2 Ovladani monitoru

PHILIPS

[1] X2)
r"fliﬁ
o =

© Vstup napdjeni
© VstupVGA El Popis vyrobku z éelniho pohledu
© Vstup DVI-D
O Zimek proti krddeZi Kensington 197E3L
v v v (5}
Pripojen( k pocitaci
. ) @7/'/>/A B/« /0K [0}
1. Pevné pripojte napdjeci kabel k zadnf | | I\ | |
strané monitoru. (7] (6] © e o o
2. Vypnéte pocita¢ a odpojte jeho napdjecl
kabel. 197E3L (model 1A)
3. Pripojte signdlovy kabel monitoru do Py
video konektoru na zadnf strané pocitace.
4. Zapojte napdjeci kabel pocftace a @V £9/A /4 /0K 10)
monitoru do nejblizsi zasuvky. | | (Y | |
5. Zapnéte pocitac a monitor: Jestlize se o 06 oo o
na monitoru objevi obraz, instalace je
dokoncena. o o Slouzi k zapnuti a vypnuti napajen(
monitoru.
O &)/0K|Slouzi ke vstupu do nabidky OSD.
Slouzi k ndvratu na predchozf
© < droveri OSD.
o FOf)  |Zmérite formdt zobrazent.
O-  |Upravte Urover jasu.
© | A V¥V SlouZ k nastaveni OSD.
® Slouzi ke zméné zdroje vstupniho
(6] signdlu.
FO) |Zménte formét zobrazent.
Smartlmage Lite. K vybéru jsou
@ @ |3 refimy: Standard (Standardni),
Internet, Game (Hra).




E1 Popis zobrazeni funkci na obrazovce Nabidka OSD

Co je nabidka na obrazovce (OSD)? NiZe je uveden celkovy pohled na strukturu OSD.
Tento prehled mlzete vyuzit, budete-li chtit

Funkcf nabidky obrazovky (On-Screen Display, pozdéji prozkoumat rliznd nastavent.

OSD) jsou vybaveny viechny monitory Philips.

Umozniuje koncovému uzivateli upravovat Mainmenu  Sub menu

vlastnosti obrazovky nebo vybirat funkce VeA

monitoru pifmo prostitednictvim zobrazeného . L ot e for stcone oty

okna s pokyny. Nize je uveden priklad prfjemného

rozhrani obrazovky: I Picture Format ~ — Wide Screen, 43
Brightness — 0~100

197E3L Contrase T o
SmartContrast — On, Off

VGA
Input =
mﬂ; Color Temperature — 6500K, 9300K
— Color
sRGB
User Define Red: 0~100
E Green: 0~100
Blue: 0~100

— Language — English . Espaiiol, Frangais, Deutsch, ltaliano,

Portugués, Pycckuit, {8 RH 3L, Tirkge

r— Horizontal — 0~100
|— OSD Settings
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time out — 55,105,205,305,60s
Picture Format © de en
— e L — Setup — Auto
Brightr < L 10
— H. Position — 0~100
Contrast L 5o
Sr 0off — V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes,No
L— Information

Zakladni a jednoduché pokyny k ovladacim
tlacitkm

Ve vySe uvedené nabidce obrazovky OSD mohou
uZivatelé pomocf tlacitek w A na prednim rdmu
monitoru pohybovat kurzorem, OK potvrzovat
vybér nebo zménu.



El Poznimka k rozliden 2.3 Odpojte stojinek podstavce a podstavec
Tento monitor je uréen pro optimdini vykon pri El Demonti’ stojanku podstavce

nativhfm rozlisenf 1 3.66 X 768. pfi 60 Hz Kdyz je NeZ za¢nete demontovat podstavec monitoru,
monitor zapnut pfi jiném rozlidenf, na obrazovce se  postupujte podle pokynd nize, aby se zabranilo

zobraz( vystraha: Pro dosazeni nejlepsich vysledkd poskozeni nebo zranént.

pourzijte rozliseni 1366 x 768 pri 60 Hz.

Zobrazovéni vystrahy na nativni rozlisenf Ize 1. Umistéte monitor obrazovkou doll na meékky
vypnout v &sti Setup (Nastaveni) v nabidce OSD. podklad, aby nedoslo k poskrdbdni obrazovky.

B Fyzické funkce

Ndéklon

2. Zéakladnu uvolnéte ze stojanu zdkladny takto:

(1) Prsty utahnéte Sroub umistény na spodnf
strane zdkladny.

(2) Jemnym pohybem nahoru a dold uvolnéte
zdpadku, kterd zajistuje zdkladnu, a
vytdhnéte zékladnu ze stojanu zékladny.




El Demontdz podstavce

1. MlZete pouzit Sroubovak na Srouby s plochou
hlavou, ktery vsunete do dvou uvolriovacich
otvorl na krytu zdvésu, a jemné Stouchnout do
krytu zavésu a odstranit jej.

2. Odmontujte 4 Srouby a potom sejméte podsta-
vec z monitoru.




3. Optimalizace Obrazu

3.1 Smartimage Lite
E Cojeto?

Funkce Smartlmage Lite nabizi scéndre, které
optimalizujf zobrazen( réiznych typd obsahu a
dynamicky zlep3uje jas, kontrast, barvy a ostrost

v redlném case. Funkce Philips Smartlmage Lite
prindsi optimalizované zobrazeni monitoru bez
ohledu na to, zda pracujete s aplikacemi, prohlizite
obrdzky nebo sledujete video.

E1 Pro¢ to potFebuii?

Protoze chcete sledovat monitor; ktery prinasi
optimalizované zobrazen{ viech vasich oblibenych
typl obsahu. Software Smartlmage Lite dynamicky
upravuje jas, kontrast, barvy a ostrost v redlném
¢ase pro dosazeni nejlepsiho zdzitku ze sledovdn(
monitoru.

E Jak to funguje?

Smartlmage Lite exkluzivni Spickovd technologie
spole¢nosti Philips, kterd analyzuje obsah zobrazeny
na obrazovce. Na zédkladé vdmi zvoleného scéndre
technologie Smartimage Lite dynamicky zlepsuje
kontrast, sytost barev a ostrost obrazu pro
vylepseni zobrazovaného obsahu — vie v redlném
Case stisknutim jediného tlacitka.

Bl Jak aktivovat Smartimage Lite?

D,

PHIPS

|

1. Stisknutim [E) se Smartlmage Lite zobrazl na
obrazovce;

2. Opakovanym stisknutim Bf) mCzete piepinat
mezi rezimy Standard (Standardni), Internet,
Game (Hra).

3. Zobrazeni Smartlmage Lite zUstane na
obrazovce po dobu 5 sekund nebo mUzete
rovnéz potvrdit stisknutim tlacitka ,, OK".

4. Po aktivaci technologie Smartlmage Lite je
automaticky deaktivovano schéma sRGB. Aby
bylo mozné pouzit schéma sRGB, je treba
deaktivovat funkci Smartimage Lite stisknutim
tlatitka @) na prednim panelu monitoru.

Kromé tlacitka @) pro posun doll mizete rovnéz
provést vybér stisknutim tlacitek w A, potvrdit
vybér stisknutim tlacitka ,,OK" a ukondcit nabidku
Smartlmage Lite OSD.



K vybéru jsou 3 rezimy: Standard (Standardnf),
Internet, Game (Hra).

@ SmartImage U

Standard

Internet

Standard (Standardni): Vylepsuje text a
snizuje jas pro zvysenf Citelnosti a omezenf
naméhan( zraku. Tento rezim podstatné
zvysuje Citelnost a produktivitu pri praci

s tabulkami, soubory PDF, skenovanymi
¢lanky nebo jinymi obecnymi kanceldrskymi
aplikacemi.

Internet: Tento profil kombinuje vylepsenf
sytosti barev, dynamického kontrastu a
ostrosti pro zobrazenf fotografif a dalSich
obrdzkd s vynikajici Cistotou v Zivych
barvdch — to v3e bez artefaktl a vybledlych
barev.

Game (Hra): Tento profil prindsi nejlepsf
herni zazitek pro hrace, protoze aktivuje
prebuzeny okruh pro optimdlni dobu
odezvy, omezen( zubatych okrajd rychle

se pohybujicich objektl na obrazovce a
vylepsenf kontrastntho poméru pro jasné a
tmave scény.

10

3.2 SmartContrast
El Cojeto?

Jedinecna technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastn pomér monitoru pro maximalni vizualnf
Cistotu a pozitek ze sledovéni, Zvy3uje podsviceni
pro jasnéjsi, ostrejsi a jasnéjsi obraz nebo snizuje
podsvicen( pro jasné zobrazen{ obrazu s tmavym
pozadim.

Bl Prog to potfebuii?

Zédate nejvy33i vizudlni Cistotu a pohodli sledovéni
jakéhokoli typu obsahu. SmartContrast dynamicky
ridi kontrast a upravuje podsviceni pro jasné, ostré
a jasné zobrazen( her a videa nebo pro zobrazenf
jasného, Citelného textu pro kanceldrskou praci.
Omezenim spotreby monitoru Setifte ndklady a
prodluzujete Zivot vaSeho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v redlném
Case analyzovat zobrazeny obsah a upravovat
barvy a rfdit intenzitu podsvicenf. Tato funkce
bude dynamicky vylepSovat kontrast pro skvély
zdzitek pri prohlizenf fotografif nebo hranf her.



3.3 Philips SmartControl Lite

Novy software SmartControl Lite od spolecnosti
Phillips umoZriuje ovlddat monitor prostrednictvim
snadno pouzitelného grafického rozhrani na
obrazovce. Slozitd nastaven( jsou minulosti, protoze
tento uzivatelsky prijemny software vés provede
jemnym vyladénim rozlisenf, kalibraci barey,
nastavenim frekvence/fdze, nastavenim bilého bodu
RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovéjsi technologif
v jddrovém algoritmu pro rychlé zpracovani a
odezvuy, je pripraven rozsifit vasi zkusenost s
monitory Philips!

Instalace

* Postupujte podle pokynl a dokoncete instalaci.

*  MdZete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mizete klepnout na
zdstupce na pracovn( plose nebo na panel
nastroju.

PHILIPS

www philips.com/welcome
Monitor driver and software installation

Sy o

Windows 7. Vi, XP 2000,98.

3 s Monkor Plog and Pay support.

sofovare

I

Prvni spusténi —Wizard (Pruvodce)

Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Pravodce).

Tento privodce vds provede podrobnym
nastavenim vykonu monitoru.

Prdvodce mizete rovnéz spustit pozdéji z
nabidky Plug-in (Zdsuvny modul).

Daldf moZnosti mlZzete nastavit bez
privodce prostrednictvim podokna Standard
(Standardni).

8 smartcontol 2. phils 22581 (CS30715000001) (2 (X

SmartControl Lite PHILIPS

Wizard

Adiust &m
\% Auto Piot
. -

Color Input

) B
B

Options. Presets
o

e
\ Myt Monttors
—

Help

Start Wizard



n Spu§tén|' s podoknem standard (Standardnl'): ' smartControl 2 - Philps 22581 (CS30715000001)

Nabidka Adjust (Nastaveni):

SmartControl Lite PHILIPS

Focus

Your dispy's timing needs to be synchronied wih

Nabidka Adjust (Nastaveni) umoZriuje upravit bbbt

Brightness (Jas), kontrast (Kontrast), Focus
(Ohnisko), Position (Poloha) a Resolution

(Rozligen).

Md0Zete postupovat podle pokyni a provést

nastavenf.

Cancel (Storno) vyzivéd uzivatele, chcete-li

ukoncit instalaci.

8 smartcontrol

SmartControl Lite

Postion

W

Options
!; Resolution

W smatcontol

SmartControl Lite

]

Adjust.
Brightness
\g Contrast
Color AR
A
3 Focus
5N
\g Postion
Options
Resoltion

%

Help

1. Choose Auto Setup.
2. 1 the verticl bands ae st visbe, you'l need
to adjust the Pitch.
Pitch: Try to make the vertical bands dsappear.

]

Phase: AQust to the brghtest setting to mnimze
Adiust " movement on the screen
Bnghtness
\g Contrast . "
Color = o
iy R Phase 17
= &
Postion

_ undo _ AuoSetp

Options &
2 - Phips 22581 (C530715000001) ()X,

Resolution
E=
PHILIPS ED
Brightness

Improperly adjusted Brightness. sult in a loss of

dekal n dake! rage aras. Adst the Brighiness for

the best possbe pcture auaity W smartconto 2 phips 22581 (cs30715000001) (2]
A

the Brightness to the desred level

B st o he s, e SmartControl Lite PHILIPS

®

Position

Use the Position buttons to center the image on
your dspiay. Using You can posiion the imege
up, down, left, or right.

1. Use the Up/Down buttons to center the mage
veral,
2. st Lyt butons o caner the g
Brohtness 100 b

= & Adjust
Brightness
Undo. Reset
\g Contrast
Color ~R
~
3 Focus
5
\g Postion
Optons o undo Reset
Resolution
H!e\p (] 0
2 - Philps 22581 (€530715000001) {Z}(X e
Contrast 88 smartControl 2 - phiips 22581 (€530715000001) (%)X

Adjust the Contrast (use the sider) to keep detals in
lghter image areas.

1. Rase the Contrast un the numbers 1 and 2 SmartControl Lite PHILIPS

Resolution

B e

You are currently 3t 3 Preferred resolution. For your
dsplay to show crsp, ciear text, colors, and mages,
Your display should be set to s Preferred resolution.

I your display s at a Non-Preferred resolution, click
on the Preferred button to change your resolution to
Preferred,

Adiust > ™ Enable Resoluton Notfier
Contrast 50 Brightness Piture Format
= = T~ 43 sspect ato
. \g Contrast
Undo Reset
Color aa
- Focus
N
\E Poston
Optons x
L‘é - V”HHWHHWHHH”HH“”HH“”HH

I =—
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Nabidka Color (Barva):

Nabidka Color (Barva) umoZzniuje upravit RGB,

Black Level (Uroveri &erné), White Point (Bily
bod), Color Calibration (Kalibrace barev) a
Smartimage Lite (viz ¢ast Smartlmage Lite).
Mdzete postupovat podle pokyn( a provést

nastaven/.

V ndsledujici tabulce vyhledejte polozku
podnabidky na zakladé vaseho vstupu.

Priklad pro Color Calibration (Kalibrace barev)

8 smartContol

SmartControl Lite

L

Adjust R68

@ F.
Color White Point
% e
-y
ap
Help
8 smartControl

SmartControl Lite

]

Adiust RGB

\g Biack Level
Color White Pont:
=N

Display Gamrma

-l

Options Calibration
ap

Smartimage

&

Help

2- Philps 22581 (C530715000001) (%)
PHILIPS

Black Level

Improperly adjusted Black Level wil result n a loss of
detai n darker mage areas. Adjust the Black Level for
the best possble picture aualty.
1. Adjust the black level of the Red, Green, and
Bue using the sider bars.

Red 50

= &

Green 50

Blue 50
Undo Reset

2- Philps 22581 (C530715000001) [} X)
PHILIPS

White Point

White Point i the pont 2t wi
of red, green, and blue light
white. This effects the overal color quaity. For the
most accurate colors cick the Reset button then
select the Whke Point
1. Please select the White Point valie for the best
possble color quaity.

equal combinations

Wnite Point 6500
- - +

undo Reset.
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8 SmartControl 2- Philps 22581 (CS30715000001) |2\,

SmartControl Lite PHILIPS

Display Gamma

Gamrma is 2 component of the pixe brightness in a
display. A lower Gamma value produces brihter pixels
and a higher Gamima value produces darker pixeks. The
defauk value for Gama & 2.2.

To adjust Gamma, Smartimage must be set to OfF.
Cick the Smartlmage Off button before adjusting
Gamima,

]

Adjust
i = 1. Use the slder to select the desred Gamma.
Color Whte Pont Dipby Gamma 22
= +
Ny
Disply Gamma Smartimage OFF
L
Optons colbrtion inte e
ap
smarinage

®

Help

W smartControl 2 - Phips 22581 (CS30715000001) {7} (X,

SmartControl Lite PHILIPS

Calibration

Your dispiay needs o be properly calibrated in order
for t to produce the widest range of colors accurately
Calibration should always take place as the st tuning
step in the process. Remember to recalbrate any time.
you make indvidual adjustments to image qualty or
whenever you move your display to 3 new location.

]

t 1. Make al other necessary adjustments to irage
L auay
Adiust RGB 2. Press Show Me to learn how to use the
calibration tooks.
- . 3. Finaly, press Start to begin the calibration
process.
Black Level
59 ¥ Enable color cabration
Color software desgned n colaboration with Joseph
Holmes,
Color White Pont Protected by U.S. Patent No. 6,686,953
5o
\E Disply Gamma
Options Calbration
’
ap
Smartimage

®

Help
Show Me start

Quick View

Tlacitko ,,Show Me* (Predvést) spusti vyukovy
program pro kalibraci barev.

Start (Spustit) — zahdji sekvenci kalibrace barev
o 6. krocich.

Quick View (Rychlé zobrazen) nacte zobrazenf
pred/po.

Chcete-li se vratit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel (Storno).
Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé zobrazenf
nejsou k dispozici.

Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.



Calibration Screen (Obrazovka kalibrace) prvni  Options >Preferences (Moznosti >Predvolby) —
barvy: Tato moznost bude aktivni pouze po vybéru
e —— polozky Preferences (Predvolby) v rozeviracf
nabidce Options (Moznosti). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI jsou k
dispozici pouze karty Help (Ndpovéda) a Options

(MozZnosti).
B SmartControl 2.- Philps 22581 (CS30715000001) ()X
SmartControl Lite PHILIPS
Preferences
«  Tlagtko Previous (Pfedchozf) je deaktivovdno . P# EEE:';}Z:‘”“;j;"y:?if""““‘””“"“““““
az na obrazovku druhé barvy. \;ﬂq ) <o s
+  Tla¢ftko Next (Dal¥/) slouz k prechodu na v e
nasledujicf cil (6 cfld). \’ g
*  Tlacitko Konecny slouzi k prechodu na File > Gust o
Presets (Soubor > podokno Predvolby). \g E
* Tlacitko Cancel (Storno) slouzi k ukoncenf = 2
uZivatelského rozhranf a k ndvratu na stranku
zsuvnych moduld plug-in. \g e

Help
Smartlmage Lite
Smartimage — umozriuje uzivateli zménit nastaven(

pro vylepSent zobrazenf na zdkladé obsahu. » Zobrazf nastaven aktudlnich predvoleb.

o Zaskrtnuté tladitko aktivuje funkci. Zaskrtavaci
poli¢ko je prepinac.

* Polozka Enable Context Menu (Povolit mistnf
nabidku) na pracovni plose je ve vychozf

Kdyz je nastavena moznost Entertainment
(Zabava), jsou polozky SmartContrast a
SmartResponse k dispozici.

8 smartControl 2% Ly , . .
— = konfiguraci zaskrtnutd (Zapnuto). Po aktivaci
aErteamralle PHILIPS polozky Enable Context Menu (Povolit mistnf

smartimage nabidku) se zobrazi vybéry SmartControl
et lov koot todafs e v of ;
e Premium pro funkce Select Preset (Vybrat
\d e et e, predvolbu) a Tune Display (Ladéni zobrazen)
advst » na pracovni plose klepnutim pravym tlacitkem

mysi na mistni nabidku. Volbou moznosti
Deaktivovano bude polozka SmartControl
Premium odstranéna z mistni nabidky pravym

Back Level

White Pont.

e

“ .
Damie tlacitkem mysi.
optons c?: * Polozka Enable Task Tray (Povolit ikonu na
\g ngmz =Y hlavnim panelu) je ve vychozi konfiguraci
= o zadkrtnutd (Zapnuto). Po aktivaci polozky
o o Povolit mistni nabidku se zobraz( nabidka

Internet Standard

SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem my3i na ikonu
na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpovéda), Technical Support
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(Odbornd pomoc), Check for Update
(Vyhledat aktualizace), About (O aplikaci) a
Exit (Konec). Kdyz je deaktivovdna polozka
Enable task tray menu (Povolit nabidku na
hlavnim panelu), ikona na hlavnim panelu
zobrazuje pouze moznost EXIT (KONEC).
*  Polozka Run at Startup (Spustit pri startu) je
ve vychozi konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovdna, funkce
SmartControl Lite se nespusti pfi startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni plose

nebo prostrednictvim souboru programu. Kdyz

toto poli¢ko nenf zaskrtnuté (Deaktivovano),
Z4dnd predvolba nastavend pro spusténi pri
startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prahlednosti) (Windows 7,Vista, XP).Vychozf
nastaveni je O % neprihlednost.

Options >Input (Moznosti >Vstup) — Tato
moznost bude aktivni pouze po vybéru polozky
Input (Vstup) v rozeviraci nabidce Options
(Moznosti). Na nepodporovaném zobrazovacim
zafizeni' s podporou DDC/CI jsou k dispozici
pouze karty Help (Ndpovéda) a Options
(Moznosti). Z&dné dalif karty funkce SmartControl
Lite nejsou k dispozici.

2- Phiips 22581 (C530715000001) {7} %

PHILIPS

8 smartcontol

SmartControl Lite

Input

Adjust

§ =

g

Color

R iwiw

s

Muki Monitors

p

Help

Analog In Digital In

* Zobrazi podokno s pokyny Source (Zdroj) a
nastaveni aktudlntho zdroje vstupu.

* U zobrazovacich zafizenf s jednim vstupem
nenf toto podokno zobrazeno.

Options >Audio (Moznosti >Zvuk) —Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

8 smartControl 2. Phips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

e of the ntegrated loudspeakers by

grated loudspeakers by checking the

Adjust

CooF Tnput

Weard

g

Options Presets

e w
\ Muli Monitors
» Volume 100

Help +

Undo
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Help > User Manual (Napovéda > Uzivatelska
prirucka) — Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelska
prirucka) v rozeviraci nabidce Help (Napovéda).
Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

8 smantContol

2 - Phips 22581 (C530715000001) ()X

PHILIPS

SmartControl Lite

Adjust

5
%
&

b

(i )
update

Color ‘n
] Depiy

.
= g
Options X %

User Manual Tech. Support

Help >Version (Napovéda >Verze) — Tato
moznost bude aktivni pouze po vybéru polozky
Version (Verze) v rozeviracf nabidce Help
(Ndpovéda). Na nepodporovaném zobrazovacim
zarizeni s podporou DDC/CI jsou k dispozici
pouze karty Help (Ndpovéda) a Options
(Moznosti).

W smartcontrol 2 Philps 22581 (530715000001) (Z)X

SmartControl Lite PHILIPS

Version

0.00 EVALUATION dtune-pp-R2009-12-17-

Adiust

User Manual

p
(i ©
Update
Color a
3 Dsply D
.
\@ System 1D
Options x 'x
Y Verson

Help

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je ve
vychozi konfiguraci Aktivovana. Nabidka bude
zobrazena po zaskrtnutl polozky Enable Context
Menu (Povolit mistni nabidku) v ¢asti Options >
podokno Preferences (Moznosti > podokno
Predvolby).

g SmartControl
Select Preset ]
Tune Display

Context Menu (Mistni nabidka) obsahuje ctyri

polozky:

*  SmartControl Lite — po vybéru se zobrazi
obrazovka O aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku ulozenych preedvoleb
pro okamzité pouzitl. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviraci nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.

» Tune Display (Ladéni zobrazenf) — otevie
ovladaci panel SmartControl Lite.

*  Smartlmage Lite — zkontrolujte aktudlnf
nastaven( Standard (Standardni), Internet,
Game (Hra).
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Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu Ize zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl Lite
na hlavnim panelu. Klepnutim levym tlacitkem Ize
spustit aplikaci.

Help

Technical Support
Check for Update
About

Exik

Hlavni panel obsahuje pét polozek:

Help (Ndpovéda) — piistup k souboru s User
Manual (uzivatelskou priruckou): Otevre
soubor s User Manual (uZivatelskou priruckou)
v okné vychozho prohlizece.

Technical Support (Odbornd pomoc) —
zobraz( stranku odborné pomoci.

Check for Update (Vyhledat aktualizace) —
zobraz{ Uvodn( stranku PDI a porovnad verzi
uZivatele s nejaktudlngjsi dostupnou verz.
About (O aplikaci) — zobraz podrobné
referencni informace: verze produktu,
informace o vydanf a ndzev produktu.

Exit (Konec) — ukonci SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovn( plose
pocitace nebo restartujte pocitac.

PHILIPS

SmartCc

‘SmartControl
‘Wersion 3.20
dltune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Displays, Inc.
Patents Pending
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Deaktivovana nabidka hlavniho panelu

KdyZ je hlavnf panel deaktivovdn ve sloZce
Preference (Predvolby), je k dispozici pouze ¢dst
EXIT (KONEC). Chcete-li funkci SmartControl
Lite zcela odstranit z hlavniho panelu, deaktivujte
polozku Run at Startup (Spustit pfi startu) v ¢asti
Options >Preferences (Moznosti >Predvolby).



4. Technické udaje

Typ panelu monitoru TFT-LCD

Podsvicenf LED

Velikost panelu 18,5" (47,0 cm)

Pomér stran 16:9

Rozte¢ obrazovych bodl 0,3 x 0,3 mm

Jas 250 cd/m?

SmartContrast 20,000,000:1

Kontrastni pomér (typ.) 1000:1

Doba odezvy (typicka) 5ms

Optimdln( rozlisenf 1366 x 768 pri 60 Hz

Zomy Uhel 170° (H) /160° (V) pri C/R>10

VylepSeni obrazu Smartlmage Lite

Barevnost displeje 16,/ M

Vertikdni obnovovacf 56 Hz - 76 Hz

frekvence

HorizontdInf frekvence 31 kHz — 83 kHz

sRGB ANO

Vstup signdlu DVI-D (digitdIni), VGA (analogovy)

Vstupnf signdl Oddélend synchronizace, synchronizace podle zelené

Usnadn&ni pro uZivatele 197E3L: /v ©/a ®/4 o/ O
97BLOA @y /A B/4 =k O

Jazyky nabidky OSD anglictina, francouzstina, némcina, Spanélstina, italstina, rustina,
zjednodusend ¢instina, portugalstina, turectina

Dalsi usnadnénf Zamek Kensington

Kompatibilita s technologif DDC/CI, sRGB, Windows 7, Mac OSX; Linux

Plug & Play

Naklon -5/+20

18



Zapnuto

12,91W (typ.), 13,59W (max.)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Stridavé vstupnf Strfdavé vstupnf
napéti pri 100 VAC | napéti pri 115 VAC

Stridavé vstupnf
napéti pri 230 VAC

+/-5 VAC, +/-5 VAC, +/-5 VAC,

50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
Normalni provoz (typ.) 10,05 W 9,96 W 997 W
Spanek 05 W 05W 05 W
Vypnuto 05 W 05 W 05 W

Rozptyl tepla*

Stridavé vstupnf
napéti pri 100 VAC

Strfdavé vstupnf
napéti pri 115 VAC

Stridavé vstupnf
napétf pri 230 VAC

+/-5 VAC, +/-5 VAC, +/-5 VAC,

50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
BE&Zny provoz 30,304 BTU/hr 34,008 BTU/hr 34,024 BTU/hr
Spanek 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Vypnuto 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Indikdtor napdjenf Zapnuto: Bild, Pohotovostn( rezim/rezim spanku: Bild (blikd)
Napdjenf Vypdleni, 100-240VAC, 50-60Hz

Vyrobek s podstavce (SxVxH)

462 x 364 x 200 mm

Vyrobek bez podstavce (SxVxH)

462 x 295 x 41 mm

Vyrobek s podstavcem 2,63 kg
Vyrobek bez podstavce 2,194 kg
Vyrobek s obalem 3,724 kg

Teplotni rozsah (provoz) 0°C az 40 °C
Teplotni rozsah (mimo provoz) | -20°C az 60°C
Relativni vihkost 20% az 80%

Pousirant: + 12 000 stop (3 658 m)

Nadmor'ska vyska :
Mimo provoz: + 40 000 stop (12 192 m)
MTBF 30 000 hod.
| Eologe ]
ROHS ANO
EPEAT Certifikdt Silver. (www.epeat.net)
Balenf 100% recyklovatelny
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Znacka CE, FCC trida B, GOAST, SEMKO, TCO Certified, UL/
cUL, BSMI, ISO9241-307, Energy star 5.0

Prohldseni o shodé

Barva Cerna (zadnf) / Modry (ptedn)
Povrchovd Uprava Leskly
& Poznamka

1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolecnost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.

Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovejsi verzi letdku z webu
www.philips.com/support.
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4.1 Rezimy rozliseni a predvoleb

E Maximalni rozliseni

Pro 197E3L

1366 x 768 pri 60 Hz (analogovy vstup)
1366 x 768 pri 60 Hz (digitdIni vstup)

E1 Doporuéené rozliseni

Pro 197E3L
1366 x 768 pri 60 Hz (digitdlni vstup)

3147 720x400 70,09
3147 640x480 59,94
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
63,89 1280x1024 60,02
79,98 1280x1024 75,03
47,71 1366x768 59,79
e Poznamka

Upozomiujeme, Ze vas displej pracuje nejlépe pri
nativnim rozliseni 1366 x 768 pii 60 Hz. Chcete-

li dosdhnout nejlepsi zobrazenf, uplatnéte tuto

doporucenou hodnotu rozlisent.




5. Rizeni spotieby

5.1 Automaticka Uspora energie

Pokud je v daném pocitaci nainstalovdn software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
sniZit svou spotiebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpoznad vstup z kldvesnice,

mysi nebo jiného vstupniho zarizenf, monitor se
automaticky ,,probudi*. Ndsledujicf tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

197E3L

ReZim VESA | Video | H-synch. | V-synch. | Spotreba energie | Barva LED
Akt | ZAP. | Ano Ano | <1291 W (typ) | B
Spének VYP. Ne Ne <05W Bilé

(pohotovost) (blika)

Vypnuto VYP. - - <05W VYP.

Nadsledujic konfigurace se pouziva pri mérenf
energetické spotreby tohoto monitoru.

Nativni rozlisenf: 1366 x 768

Kontrast: 50%

Jas: 250 nitd

Barevna teplota: 6500 K s pIné bilym vzorkem

& Poznamka

Tyto ddaje se mohou zménit bez predchoziho
ozndment.
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6. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe
to use throughout its life cycle.

Congratulations,

Your display is designed for both you and the
planet!

The display you have just purchased carries the
TCO Certified label. This ensures that your display
is designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user

in focus that also minimizes the impact on the
climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO Certified
represents one of the toughest certifications for
displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

Visual ergonomics for good image quality is
tested to ensure top performance and reduce
sight and strain problems. Important parameters
are luminance, contrast, resolution, black level,
gamma curve, colour and luminance uniformity
and colour rendering

Products are tested according to rigorous safety
standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels
* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

Very low energy consumption both in on- and
standby mode minimize climate impact
Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and heavy
metals such as cadmium, mercury and lead
(RoHS compliance)

Both product and product packaging is prepared
for recycling

The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors
based on 51 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

X
Q"b

S

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)
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2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on ISO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for

Environment Labeling of Ergonomics,

Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees) for
TCO versions

Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner, we have
determined that this product meets the ENERGY
STAR® guidelines for energy efficiency.

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur

in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

Reorient or relocate the receiving antenna.
Increase the separation between the
equipment and receiver.

Connect the equipment into an outlet on

a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/
TV technician for help.

Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

25

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.



Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de fagon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréguences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, |'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre |'équipement et
le récepteur.

* Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
* Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This dewvice belongs to catagory B devices as described in EM 55022, unless it is specrli-
cally stated that it is a Class A devics on the specification labal. The following applies to
devicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of tha
devics is obliged to taks all staps necessery to remove sources of intarference to tals-
communication or other devicas.

Pakud neni na typovém &titku poditade uvedeno, Ze spadé do do fidy A podle EN 55022,
spadé automaticky do tidy B podie EN 55022, Pro zafizen zafazend do tfidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-li k rudeni telekomunikatnich nebo
Pnych zafizeni je ufivatel povinmen provést takovd opatfgnl, aby rudeni odstranil.
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Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Pelskiego Centrum Badan i Certyfikacji

Pozostale instrukeje bezpieczensiwa
* Niena Ty s

af Kilka albwisd
ayt przediuz

North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

| azearazogs |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Rontgenverordnung erfiillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1.

Reparaturen nur durch Fachpersonal
durchgefihrt werden.

2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine bauartgleiche

eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhohte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

[A]

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.

FEABLEROHS

REPEAN (ATREFRISRERASENE) (HRAPEAMROHS)
BURRRG RIS T A SR SN S E SNRNTANSHNEE
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B (WRKRCRT)
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B EER AEAEYRETE
@ E 7 S| SmBEE | SRoEm
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HE s @) [8) [e) [} e}
RTETR x @) 8 [e) e [¢)
(RERTEAE X [8) 8 [e] e ¢}
mHARARAT x [s) 8 o) e o)
TREEEE x [e) 8 o) e o)
REEERR | X @) 8 o] e} o)
¥ BEAEA DEORRBE R LA N0 R SRl - TEEE
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{RFEET AP ARG ENHORRERFE) REORRERUT
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech plochého panelu
spole¢nosti Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektlim pixell
nebo subpixell u panell monitoru TFT, které se
pouzivaji pro ploché monitory, se nicméné nékdy
nedd zabrdnit. Zddny vyrobce nemUze zarucit, ze
Zadny panel nebude obsahovat vadné pixely, ale
spolecnost Philips zarucuje, Zze kazdy monitor s
neprimérenym poctem defektl bude opraven
nebo vyménén

v rdmci zdruky. Tento text vysvétluje jednotlivé
druhy defektl na pixelech a urcuje dnosnou
Uroveri chybovosti pro kazdy druh. Aby bylo
mozné uplatnit zdrucni opravu nebo vymeénu,
musi pocet chybnych pixell panelu monitoru
TFT presdhnout tuto Uroven Unosnosti. Na
monitoru napiiklad nesmf byt vice defektnich
dil¢ich obrazovych bodt nez 0,0004 %. Déle,
protoze nékteré typy kombinaci vad pixeld jsou
lépe postrehnutelné nez jiné, stanovuje pro né
spole¢nost Philips jeste vétsi ndroky na kvalitu. Tato
norma se dodrzuje celosvétove.

subpixel subpixel subpixel

vy
il B

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze tif
subpixell v zdkladnich barvdch cervené, zelené a
modré. KdyzZ je mnoho pixell pohromadg, tvorf
obraz. Kdyz viechny subpixely uréitého pixelu
svitf, jevi se tyto tfi subpixely spole¢né jako jediny
bily pixel. Kdyz jsou vSechny tmavé, jevi se tyto trf

subpixely jako jeden cerny pixel. Dalsi kombinace
rozsvicenych a tmavych subpixeld se jevi jako
pixely riznych barev.

Druhy pixelovych vad

Vady pixell a subpixell se na obrazovce projevujf
rlznymi zpUsoby. Existuj dva druhy vad pixelu a v
ramci téchto druhd je nékolik typl subpixelovych
vad.

Kazy Jasnych Bodu

Defekty svétlych bodl se projevuji jako obrazové
body nebo dil¢i obrazové body, které vzdy svitf
nebo jsou ,aktivni’. Svétly bod je dil¢i obrazovy
bod, ktery vystupuje

z obrazovky, kdyz je na monitoru zobrazena tmava
plocha. Existuji ndsledujici typy defektd svétlych
bodu:

Jeden Cerveny, zeleny nebo modry subpixel

I C

Dva soundlezicl subpixely:

- Cerveny + modry = fialovy

- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry



Tri soundlezicl rozsvicené subpixely (jeden bily
pixel)

€ Poznamka
Cerveny nebo modry svétly bod musf byt o vice
nez 50 procent jasné€si, nez sousedni body; zeleny

svétly bod je o 30 procent jasné&jsi, nez sousednf
body.

Kazy Cernych Boda

Defekty tmavych bodud se projevuji jako obrazové
body nebo dil¢f obrazové body, které nikdy
nesviti nebo jsou ,neaktivni’. Tmavy bod je dil¢f
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena svétla plocha. Existujf
nasledujici typy defektd tmavych bodu:

30

Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixell stejného typu,
které se vyskytuji blizko sebe, mohou byt patrnéjs,
urcuje spolecnost Philips i tolerance na vzdélenost
vad pixeld.

Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli vaddm pixeld v zaruéni dobé, musi panel
monitoru TFT v plochém monitoru Philips vady
pixell nebo subpixeld, které prekracuji tolerance
uvedené v ndsledujicich tabulkdch.




KAZY JASNYCH BODU PRIJATELNY POCET VAD

1 trvale svitici bod 3

2 sousedni trvale sviticf body 1

3 sousedni trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodt viech typl 3

1 tmavy bod 5 nebo méné
2 sousedni tmavé body 2 nebo méné
3 sousedni tmavé body 0
Vzddlenost mezi dvéma kazy cernych bodi* >15 mm
Celkovy pocet kazli ¢ernych bodu viech typt 5 nebo méné

KAZY BODU CELKEM PRIJATELNY POCET VAD
Celkovy pocet kazl jasnych nebo cernych bodu viech typt 5 nebo méné
& Poznimka

1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
Tento monitor je kompatibilnf se standardem 1SO9241-307.(1SO 9241-307: Ergonomie systémovych
interakef clovéka: Analyza a ovérovaci zkusebni metody pro elektronické zobrazovaci displeje)
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7.2 Péce o zakazniky & zaruka

Péce o zédkazniky & zaruka

Podrobné informace o zéruce a pozadavku na dodate¢nou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena

Austria Siemens &S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 € 0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Germany Siemens &S +49 01803 386 853 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €008
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €010
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Kontaktni informace pro oblast STREDNI AVYCHODNI EVROPY:

::::r'!::joi:lg Cislo zékaznické péce
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
Hungary NA Serware , +36 12426331
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
E’Iec::i;r%egro NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
Ut NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Kontaktni informace pro oblast LATINSKE AMERIKY:

Cislo zakaznické péce
0800 3330 856

Telefonni stredisko

Argentina Vermont

Brazil Vermont 0800-7254101

Kontaktni informace pro SEVERNI AMERIKU:

Zemé Telefonni stredisko ASC Cislo zakaznické péce
Canada Supercom Supercom (800) 479-6696
USA. TOS Teleplan (877) 835-1838

Kontaktni informace pro Cinu:

Cina
Cislo zékaznické péce: 4008 800 008
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Kontaktni informace pro oblast APMEA:

Telefonni
stredisko

Cislo zakaznické péce

Ltd.

Australia NA AGOS NETWORK PTY LTD 1300 360 386
Bancladesh NA Distributor: Computer Source 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology Pte
Cambodia NA Ltd (Singapore) (warranty buy- | 855-023-999992
out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. |y -\ Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
‘ , ‘ ‘ . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
Malaysia NA Q;tctjer Market Solutions (CE) Sdn 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977.1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 2737411-16
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea | NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d.IStI‘IbUtOF and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
United Arab 0 AL SHAHD COMPUTER LL.C | 00971 4 2276525
Emirates
. : +84 8 38248007 Ho Chi Minh City
Vietnam NA FPT Service Informatic Company | a4 5413 562666 Danang City

+84 5113.562666 Can tho Province
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8. Odstranovani problému a
Casté dotazy

8.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy, které
mUze odstranit uzivatel. Pokud problém pretrvava
i po vyzkousen( téchto feSeni, kontaktujte zdstupce
sluzeb pro zdkazniky spole¢nosti Philips.

El B&iné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjeci kabel pripojen
k elektrické zdsuvce a do zadnf &3sti monitoru.

*  Nejdrfve zkontrolujte, zda se vypina¢ na prednf
stran& monitoru nachézi ve VYPNUTE poloze
a stisknéte jej do ZAPNUTE polohy.

Zadny obraz (indikator LED napajeni blika bile)

»  Zkontrolujte, zda je zapnuty pocftac.

»  Zkontrolujte, zda je kabel signdlu radné
pripojen k pocitadi.

»  Zkontrolujte, zda nejsou ohnuté koliky na
pripojovaci strané kabelu monitoru. Pokud ano,
opravte nebo vymeérite kabel.

*  Pravdépodobné je aktivovédna funkce rizenf
spotreby

Obrazovka Fika

Attention

Check cable connection

*  Zkontrolujte, zda je kabel monitoru radné
pripojen k pocitaci. (Rovnéz viz Privodce
rychlym pouzivdnim).

»  Zkontrolujte, zda nejsou ohnuté koliky kabelu
monitoru.

» Zkontrolujte, zda je zapnuty pocitac.
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Tlaéitko AUTO nefunguje

* Automaticka funkce je pouzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizete provést rucni dpravy
prostrednictvim nabidky OSD.

© Poznimka
Automaticka funkce nenf pouzitelnd v rezimu DVI-
digitdIni, protoze je zbytecnd.

Viditelné znamky koure nebo jiskFeni

*  Neprovéddéjte zddné kroky pro odstrariovani
problém

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zastupce sluzeb pro
zdkazniky spole¢nosti Philips.

El Problémy se zobrazenim

Obraz neni vystredén

*  Upravte polohu obrazu pomoci funkce , Auto’
v hlavnich ovlddacich prvcich OSD.

*  Upravte polohu obrazu pomocf polozek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddacf prvky OSD).Tato funkce je platnd
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

» Zkontrolujte, zda je kabel signdlu radné a
bezpecné pripojen ke grafické desce nebo k
pocftaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomoci funkce , Auto*
v hlavnich ovlddacich prvcich OSD.



Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovladacf prvky OSD).Tato funkce je platna
pouze v rezimu VGA.

Dochazi k vodorovnému blikani

Upravte polohu obrazu pomocf funkce , Auto’
v hlavnich ovladacich prvcich OSD.

Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD).Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis tmavy
* Upravte kontrast a jas na obrazovce OSD.
,Dosvit", ,,vypéleni* nebo “zobrazeni duchd*
zUstane po vypnuti napdjeni

Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpuUsobit , vypaleni obrazovky, rovnéz zndmé
jako ,,dosvit" nebo ,,zobrazenf duchd*.

., Vypélen*, , dosvit" nebo , zobrazeni duchd*
je dobre zndmy jev u technologie panell
monitoru.V mnoha pripadech ,vypdleni*,

,, dosvit" nebo ,zobrazeni duchd" postupné
zmizi po urcité dobé mimo provoz.

Pred ponechanim monitoru bez dozoru vzdy
aktivujte spori¢ obrazovky.

Bude-li na vaSem monitoru zobrazen neménicf
se staticky obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Vézné priznaky , vypéleni",, dosvitu" nebo
,,zobrazeni duchd' nezmizf a nelze je opravit.
Na vySe uvedené poskozen( se nevztahuje
zdruka.

Obraz je zdeformovany.Text je nejasny nebo
rozmazany

Nastavte rozlieni zobrazeni pocitace na stejny
rezim, v jakém se nachdzi doporucené nativni
rozlideni obrazovky monitoru.

Na obrazovce se objevuiji zelené, cervené, modré,

tmavé a bilé tecky

»  Zbyvajici body jsou normdéini vlastnostf
tekutych krystald pouzivanych soucasnou
technologif. Dalsi podrobnosti viz pravidla pro
obrazové body.

Svétlo indikatoru ,,napajeni je prilis silné a rusi
MdZzete nastavit intenzitu svétla indikdtoru
,napdjeni v ¢asti Power LED (Indikdtor LED
napdjeni) v c¢asti Setup (Nastaveni) v OSD
Main Controls (Hlavni ovlddaci prvky nabidky
OSsD).

Potrebujete-li dalsi pomoc, viz seznam Informacnf
strediska pro zdkazniky a kontaktujte zdstupce
sluzeb pro zdkazniky spolecnosti Philips.
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8.2 SmartControl Lite - casté dotazy

OTAZKA 1:

Odpovéd:

OTAZKA 2:

Odpovéd:

Zménil jsem monitor v pocitaci za
jiny a technologie SmartControl
Lite se stala nepouzitelnou, co

am délat?
mam defat Odpovéd:

Restartujte pocitac a zjistéte, zda
technologie SmartControl Lite
funguje.V opacném pripadé bude
tfeba odebrat a znovu nainstalovat
SmartControl Lite, aby bylo
zaji$téno, Ze je nainstalovan spravny
ovladac.

Technologie SmartControl Lite
drive dobre fungovala, ale nyni
nefunguje, co mam délat?

Pokud byly provedena ndsledujicf
kroky, bude pravdépodobné
nutné znovu nainstalovat ovladac
monitoru.

Pouzijte jiny graficky adaptér videa
Zaktualizujte ovladac videa
Cinnosti na opera¢nim systému,
napriklad aktualizace nebo oprava
Spust'te sluzbu Aktualizace
Windows a zaktualizujte ovladac
monitoru a/nebo videa

Operacni systém Windows byl
zaveden, kdyz byl monitor vypnuty
nebo odpojeny.

Chcete-li ziskat dal3f informace,
klepnéte pravym tlacitkem

mysi na My Computer (Tento
pocitac) a klepnéte na Properties
(Vlastnosti) -> Hardware
(Hardware) -> Device Manager
(Spravce zarizen).

Pokud je pod polozkou Monitor
uvedeno ,,Plug and Play Monitor*
(Monitor Plug and Play), je tfeba
provést novou instalaci. Jednoduse
odeberte a znovu nainstalujte
SmartControl Lite.

Odpovéd:
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OTAZKA 3:

OTAZKA 4:

Kdyz po nainstalovani
SmartControl Lite klepnu na
kartu SmartControl Lite, ani po
chvili se nic nezobrazi nebo se
zobrazi zprava o chybg, co se
stalo?

V&3 graficky adaptér
pravdépodobné neni kompatibilnf
s technologif SmartControl Lite.
Pokud je vas graficky adaptér mezi
vySe uvedenymi znackami, zkuste
stahnout nejaktudlnéjsi ovladac
grafického adaptéru z webovych
stranek prislusného vyrobce.
Nainstalujte ovladac. Odeberte a
znovu nainstalujte SmartControl
Lite.

Pokud presto nefunguje,

graficky adaptér bohuzel nenf
podporovan. Na webovém serveru
spolecnosti Philips zjistéte, zda je
k dispozici zaktualizovany ovladac
SmartControl Lite.

Po klepnuti na Product
Information (Informace o
produktu) se zobrazi pouze
castecné informace, co se stalo?

Pravdépodobné nemdte k dispozici
nejaktualnéjsi verzi ovladace
adaptéru grafické karty, kterd plné
podporuje rozhrani DDC/CI.
Pokuste se stdhnout nejaktudingjsi
ovlada¢ grafického adaptéru

z webovych stranek prislusného
vyrobce. Nainstalujte ovladac.
Odeberte a znovu nainstalujte
SmartControl Lite.

Attention

Theft Deterence enabled




OTAZKA 5:

Odpovéd:

Zapomnél jsem svuj kod PIN pro
funkci zabezpeceni proti kradezi.
Co mam délat?

Servisnf stedisko Philips md pravo
Zadat legitimn( identifikaci a ovérenf
pro zjistén( viastnictvi monitoru.

Upozormiujeme, ze jako prihodnd
volnd moznost je k dispozici funkce
pro zamezeni krddeze. Sprava Cisel
PIN je vyhradni odpoveédnostf
kazdého uZivatele nebo organizace,
kterd je nastavi.

Pokud ¢islo PIN zapomenete,
servisni centrum Philips vam je
mUZze nastavit znovu za nominalnf
sazbu po ovérenf vlastnictvi.

Na tuto cinnost se nevztahujf
standardni zdru¢ni podminky.
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8.3 Obecné casté dotazy

OTAZKA 1:

Odpovéd:

KdyzZ nainstaluji svij monitor, co
mam udélat, kdyZ se na obrazovce
zobrazi zprava ,,Cannot display
this video mode* (Tento rezim
videa nelze zobrazit)?

Doporucené rozliSenf pro tento
monitor: 1366 x 768 pri 60 Hz.
Odpojte vsechny kabely, potom
pripojte pocita¢ k monitoru, ktery
jste pouzili predtim.

V nabidce Start opera¢niho
systému Windows vyberte
Settings/Control Panel (Nastaveni/
Ovladaci panely).V okné Control
Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazeni).

Na panelu Display Control
(Zobrazen( — vlastnosti) vyberte
kartu ,,Settings” (Nastaveni). Na
karté nastaveni v poli oznaceném
,desktop area" (pracovni plocha)
presurite posuvnik na 1366 x 768
obrazovych bodu.

Klepnéte na ,,Advanced
Properties” (Upresnit), nastavte
polozku Refresh Rate (Obnovovacfl
frekvence) na 60 Hz a potom
klepnéte na OK.

Restartujte pocitac a zopakovanim
kroku 2 a 3 ovérte, zda je pocitac
nastaven na 1366 x 768 pri 60 Hz.
Vypnéte pocitac, odpojte stary
monitor a znovu pripojte monitor
Philips.

Zapnéte monitor a potom zapnéte
pocitac.

OTAZKA 2:

Odpovéd:

OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

Jaka je doporucena obnovovaci
frekvence monitoru?

Doporucend obnovovaci frekvence
u monitord je 60 Hz.V pripadé
jakéhokoli ruseni na obrazovce ji
mUZete nastavit na 75 Hz a uvidite,
zda ruseni zmizi.

Co jsou soubory .inf a .icm
na disku CD-ROM? Jak Ize
nainstalovat ovladace (.inf a .icm)?

Jednd se o soubory ovladace
monitoru. Pfi instalaci ovladacd
postupujte podle pokynu

v uZivatelské prirucce. Pri

prvnf instalaci bude pocita¢
pravdépodobné pozadovat
ovladace monitoru (soubory

.infa .icm) nebo disk s ovladadi.
Postupujte podle pokynt a viozte (
doprovodny disk

CD-ROM), ktery je soucdsti této
sady. Ovladace monitoru (soubory
.infa .icm) budou nainstalovény
automaticky.

Jak mam upravit rozliseni?

Dostupnd rozlisenf uréuje grafickd
karta/ovladac grafiky a monitor.
Pozadované rozliseni mdzete vybrat
v ¢asti Control Panel (Ovlddacf
panely) systému Windows® v asti
,Display properties" (Zobrazeni -
vlastnosti).



OTAZKA 5:

Odpovéd:

OTAZKA 6:

Odpovéd:

OTAZKA 7:

Odpovéd:

OTAZKA 8:

Odpovéd:

Co kdyz se béhem nastaveni
monitoru ztratim prostrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset” (Obnovit)
obnovte viechna plvodni nastavenf
vyrobce.

Je obrazovka monitoru odolna
proti poskrabani?

Obecné se doporucuje
nevystavovat povrch panelu
nadmeérnym dderlm a chrénit

jej pred ostrymi nebo tupymi
predméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu zadny tlak ani sflu. Mohlo by
to negativné ovlivnit vade zarucnf
podminky.

Jak Ize cistit povrch monitoru?
Pro bé&zné cisténi pouzijte Cisty
a mékky hadrik. Pro didkladné
cistén( pouzijte izopropyl
alkohol. NepouZivejte Zddnd jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

Lze ménit nastaveni barev
monitoru?

Ano, nastaveni barev mizete
zménit prostrrednictvim nabidky
OSD podle nésledujicich krokd:
Stisknutim tlacitka ,,OK" zobrazte
nabidku OSD.
Stisknutim tlacitka , Sipka dold*
vyberte volbu ,Barva* a stisknutim
tlacitka ,,OK" preejdéte na nastavenf
barev. K dispozici jsou tri nastaven(
(viz nize).
1. Color Temperature (Teplota
barev): 2 nastavenf jsou 6500 K a
9300 K.

2. sRGB: standard pro zajisténf
sprdvné prenosu barev mezi
rdznymi zarizenimi (napft. digitalnf
fotoapardty, monitory, tiskarny,
skenery atd.)

3. User Define (UzZivatelské):
uzivatel si mdze zvolit viastnf
nastaveni barev upravenim
Cervené, zelené a modré slozky.

© Poznimka

Mereni svétla barvy, které vyzaruje predmét pri
zahrfvani. Toto mérenf je vyjddreno v absolutnim
méritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004 K jsou cervené; vyssi teploty, jako
napfiklad 9300 K, jsou modré. NeutrdIni teplota je
bila pri 6504 K.

OTAZKA 9:  Lze pFipojit tento monitor k
libovolnému poéitaci, pracovni
stanici nebo pocitaci Mac?

Odpovéd: Ano.Vsechny monitory Philips jsou
pIn& kompatibiln{ se standardnimi
pocitadi, pocitaci Mac a pracovnimi
stanicemi. Pro pripojeni monitoru
k systému Mac mudze byt zapotrebf
kabelovy adaptér. Dal3i informace

zdstupce Philips.

OTAZKA 10: Jsou monitory Philips vybaveny
technologii Plug-and-Play?

Odpovéd: Ano, tyto monitory jsou
kompatibilni s technologif
Plug-and-Play v operacnim systému
Windows 7,Vista, XP NT, Mac OSX
a Linux.
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OTAZKA 11:

Odpovéd:

D Vystraha

Co znamena Ipéni obrazu, vypéleni
obrazu, dosvit nebo ,,duch*
v souvislosti s panely monitoru?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mize zpUsobit
,Vvypaleni* obrazovky, rovnéz zndmé
jako ,,dosvit" nebo , zobrazenf
duchd". ,,Vypélen*, ,dosvit" nebo
,zobrazeni duchd" je dobre zndmy
jev u technologie paneld monitoru.
V mnoha pripadech , vypalenf”,
,,dosvit'' nebo ,,zobrazeni duchd"
postupné zmizi po urcité dobé
mimo provoz.

Pred ponechdnim monitoru bez
dozoru vzdy aktivujte spori¢
obrazovky.

Bude-li na vasem monitoru
zobrazen neménici se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Vézné priznaky ,vypéleni*,, dosvitu" nebo
,zobrazenf duchd" nezmizi a nelze je opravit. Na
vy3e uvedené poskozenf se nevztahuje zdruka.

OTAZKA 12: Proc se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji zobrazené
znaky zubaté okraje?

V43 monitor nejlépe pracuje pri
svém nativnim rozliseni 1366 x
768 pri 60 Hz. Pouzivejte toto
rozliseni pro dosazeni optiméiniho
zobrazen.
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